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Panzer Campaigns: Tunisia ‘43 
Getting Started 
Welcome to Panzer Campaigns: Tunisia ‘43. The Western Allies have struck back at the Axis with their first major 

European landings, aimed at the Axis rear in North Africa, driving on the Vichy French cities and ports in Tunisia including 

Bizerte and Tunis.  The Germans and Italians counter with forces airlifted to airfields in the area, stopping the initial 

allied advance and leading to an extended campaign for final control of North Africa that historically ended with the 

capture of hundreds of thousands of Axis soldiers.  The started scenario represents a small action by one of the Allied 

forces, Blade Force, pushing on Tunisia shortly after their landings. 

 

 

Blade Force, a British/US armored task force, was ordered to drive through Hunt's Gap on Sidi Nsir, seizing it before the 

Germans could consolidate their hold on the area, as one of three prongs pushing on Tunis. 
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Familiarize yourself with the elements around the map shown in the image on above. These are: 

 Unit Box - in the top left corner - provides information about the unit(s) that may be highlighted on the map. 

 Terrain Box - right below the Unit Box - provides information about the ground in the selected map hex. 

 Toolbar and Menu Bar - common elements of any Windows Interface – provide shortcuts to control the game 

functions. 

 Status Bar - on bottom left - shows the current time, date, turn progression, ground condition, and 

night\daylight conditions. This area also displays information about why an action you may be attempting is not 

allowed by the game or rules. 

 Time and Location Bar - on bottom right - shows the time of day with respect to night\day and remaining 

daylight. The current hex coordinates of the selected hex are to the right of the time bar. 

 Objective Hex – in the center part of the map, is a location worth points to the first side, generally important 

locations in the scenario, they are goals to work toward  for achieving a win for both sides. 

 Supply Hexes – Axis to the north, Allied to the southwest, are hexes that provide supply to each side when using 

certain supply optional rules. 

Scenario Selection 

 

Start Tunisia '43, if you have not already done so, and you will be taken to the File Selection Dialog.  

Click the scenario #00_Started.scn file in the upper right corner of the Dialog. Review the information in the scenario 

Description and press OK when you are ready to continue. 
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When you press OK on the File Selection Dialog, you are taken to the A/I Selection Dialog, where you choose the side 

you wish to control. For the purposes of this tutorial, leave the Allied A/I set as "Manual" for you and select the 

"Automatic with FOW (Fog-of-War)" for the Axis A/I.  

Clicking on the Rules button allows you to select the optional rules.  Click on the Rules button now. 

We want to play with the default rules for Tunisia '43 so click Default if this is not your first time playing, otherwise the 

rules should already be the default – the game will start up with the last set of rules selected.  Then click on OK. 

Click OK to start the game. You are now the Allied commander, while the A/I is the Axis. 
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The map will now appear on your screen, along with 

your first Command Report. A Command Report will 

appear at the start of every turn and contains useful 

information.  

The first Command Report, at the beginning of the 

game, is fairly brief without much critical information. 

However, it does tell you *** Air units are available 

***. You will come back to Air units later. Click OK to 

proceed. 

 

Objective of the Game 
On the Menu Bar, click Info and then Victory…. The Victory Dialog shows how many points the first side (the Allied, in 

this case) must earn for each level of victory. 

 

As you can see, to obtain a major victory in this battle, the Allied 

player must earn 125 Victory Points by the scenario’s end. If you get 

110 points, you earn a minor victory.  Over 95 points is a draw. Less 

than 95 points will result in a  defeat. 

Click OK to close the Victory Dialog.  
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If you look at the map, you will see an oval shape with the values 

of 100 inside. This is your objective.   Most scenarios have more 

than one objective but this one is kept simple so you can 

concentrate on one objective. 

 

 

 

 

 

To win a major victory, you need to capture and hold this objective before game end and inflict enemy casualties equal 

to 25 points more than you lose. As you incur losses, points are taken away from you.  

 

The visible units on the map are yours, some are British (tan) and others are US (olive green).  In this case, no enemy 

units are visible, you will have to find them, they will become visible through recon, if they start a turn in line-of-sight, 

you move adjacent to them or they fire will in your LOS. 

 

The Terrain Information box shows visibility is ‘2km.’   

 

 

(Tip: Each hex is 1 km across. Visibility and ranges are all expressed in km’s and counted in 

hexes.) 
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The Time and Location Bar in the bottom right corner shows the time is about midday, the white bar is day, the black 

night.  If the scenario had dawn/dusk turns with limited daylight, there would be grey shading also.  

 

 

 

As you can see from the Status Bar, it is actually 12:00 25 November 1942, the Allied Turn, 1st of 5 turns, Soft ground 

conditions.  

 

Turn 1 

Movement Basics 

Panzer Campaigns is a turn-based game. Side One, the Allied forces in this scenario, perform all actions - Moving, Firing, 

Calling in artillery or air support etc. - in any order you like. Each unit action expends Movement Points, or MPs. Units 

may also have actions applied to them that don't expend movement points, such as digging in.  When you are done with 

all the units you want to move and fire, you end your turn. Then, the second player - in this case, the A/I - plays his turn. 

After both players have taken turns, the time is advanced one game turn, or two hours of real time, and the cycle is 

repeated. 

 

The Divisional Markings button will color the unit symbol for each unit showing which division/formation the units 

belong to.  Similar color means the units belong to the same formation and they will function best when they remain 

together.   If you hover the cursor over the button, you will see a tool tip. This button enables Divisional Markings.  In 

this case, all the allied units belong to the same division, the 78th Inf Div so all have the same color for their unit symbol. 

(Tip: Try to keep similar colored units together, as it assists the parent HQ in carrying out its command functions. Later, 

when you review the full game instructions, you will learn more about this Command & Control concept.) 
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Select the unit indicated by the yellow arrow. The icon indicates it is a recon type unit, formed of vehicles. A Red Box, or 

Hot Spot, will appear in the hex. 

A unit picture will now appear above the Terrain Info box. 

 

The unit picture shows a Vehicle – recon car specifically - and you can see the unit is made up of 5 vehicles and is full 

strength as indicated by the 100%. You can also see the Morale is C  which is “average”; in game terms it won't have 

bonuses or penalties for checks that use Morale. The unit has 84 MPs. Fatigue is ZERO, meaning the unit is fresh. When a 

unit fights, Fatigue levels build and it becomes less effective until it is rested. 

 

 

To check further details on this unit, right click on it. On the left side of the Unit box, 

you will see the chain of command for the unit. The unit’s combat factors, with speed in 

km/h, are shown on the right side. Some units may display specialty functions, such as 

Engineer or Recon.  

To practice moving units, you are now going to move this toward the enemy.  Double click to select this unit on the map, 

or left mouse click on the Unit Box, so that the Unit Box lights up. It is now "selected" and ready for orders. 
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It is time to move it toward the objective.  

 

To do so, right click the adjacent hex, the one directly northeast (up and right) of the selected unit. The unit will jump to 

the new hex.  

(Tip: If you issue an order, movement or otherwise, and the unit does not obey the order, look at the Status Bar on the 

bottom left to see a message telling you why the order cannot be performed.)  

In this case, if you look at the unit window again, you will see the unit you moved now has 77 MPs remaining - having 

expended 7 MPs to move 1 hex in clear terrain at the same elevation.  
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There are a number of ways to move units in Panzer Campaigns. For the next movement, you are going to move a unit 

several hexes at a time using a drag move. You are going to move it 3 more hexes to the new location shown by the 

arrow. To do so, first make sure the unit is selected by double clicking on the hex, or by putting your cursor in the hex 

and then single clicking on the unit in the unit window.  

Next, clicking on the unit with the left mouse button and holding the button down, drag the mouse to the new location 3 

hexes away, as indicated by the arrow, then release the button. The unit will move to the new hex. 

 

The computer will determine the path the unit takes, so it is wise to drag small distances to control the path. Sometimes 

when you order a unit to go from A to B, it takes a path you might not expect. With Fog-of-war (FOW) on, meaning you 

cannot see the other side’s units, you are not permitted to undo your movement should it go somewhere you did not 

expect.  In this case, as you move to the destination hex, an enemy unit will appear adjacent to it. Any time you move 

adjacent to an enemy unit, spotted or unspotted as in this case, it may trigger defensive fire by any enemy units 

including artillery able to fire on your unit. 

 

So far, you have been moving infantry around. Next, you are going to move towed artillery and, as you will see, these 

units work differently. Place your cursor in the hex with the  Artillery unit shown above. 

If you select this unit and try to move it, you will find it will not obey your order. If you look at the Status Bar, you will 



 10 

see why! 

To move towed guns such as these, you have to take them out of their firing positions, limber them up to their trucks, 

load up the ammo, pack up any communication gear, and finally put all the vehicles in a mode for movement. In the 

game, this is called Travel Mode, or T Mode for short. 

Now, select the artillery unit - again, just double click the hex. 

  

With the artillery unit selected, click the Change Travel Mode button on the Toolbar. You will 

see a white line appear at the bottom of the unit icon and a "T" next to the movement points 

in the Unit Box. Notice that the movement point number dropped to 40 MPs. It takes time to 

get the unit ready to move, and this time is paid in MPs expended. Also, an artillery unit has 

to SETUP again when you take it out of Travel Mode. 

 

Travel Mode represents units in a column formation prepared for quick movement, and for towed artillery, being 

limbered. For Motorized Infantry, it means the men are loaded onto trucks, ready for transport rather than fighting or 

walking. For tanks, it means they are lined up in column, ready for movement. 

(Tip: Units that can move in both Travel Mode and non-Travel Mode (or Deployed) will generally be able to move much 

farther in Travel Mode. However, at the end of their turn, if they remain in Travel Mode, they are more vulnerable to 

enemy fire. Therefore, it is best to ensure units in Travel mode remain out of harm’s way.) 

 

With the artillery unit still selected, click the Reachable Hexes button on the Toolbar and the map 

will light up, to highlight where this unit might reach on this turn.  
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With the Unit still selected, click on the hex and hold and drag the mouse to the to the hex occupied by the Olive tank 

unit 2 hexes to the northeast. The unit will move off, following the fastest route to the destination. 

When it reaches the destination hex, the unit has 5 MPs remaining - not enough to go anywhere else. Nor is that enough 

to change out of Travel Mode and put the guns back in line to fire, as that takes 1/3 of the unit movement for most 

artillery. This unit cannot go any further. 

Now, press the Reachable Hexes button again to toggle this feature off. You are now ready to evaluate what to do next. 

(Tip: If you had enough Movement Points remaining and you were close to the front, it might be a good idea to switch 

out of Travel Mode by pressing the Change Travel Mode button again with the unit selected. However, in this case, you 

do not have enough MPs remaining.)  
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Firing: Indirect Fire & Direct Fire 

 

 

At this point you should have one enemy unit visible, the one that the recon unit bumped into earlier this turn.  It is time 

to fire at it, using both indirect (artillery) and direct fire. 

Select the Artillery Dialog from the Tool Bar to see what Units may be available for firing. 

 

 

 

In this scenario, there is only one at this point – you had 

another one but it was moved and so cannot fire as it doesn't 

have enough movement points, and additionally needs to 

Setup first. 

When any unit in a list is greyed out, it is unavailable, but 

here the unit name is bold and so it is setup, available to fire 

and has a target. For artillery units to fire, they must meet 

certain conditions. First of all, they have to be in range. 

Secondly, they must have another unit to spot or relay the 

target information to them. 

 

With any bold artillery unit selected, all valid targets for it will be highlighted with a red box around it, as shown here.  
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If you place your cursor on the map (not the dialog), you will see it is now a Crosshairs in a circle - like a sight on a gun - 

and you are ready to fire. 

Right click on the enemy unit. 

A red line will be shown on the map from the artillery unit to the target hex. You will see a small explosion, or fire 

marker. The sounds of the guns will be heard, after which a result will appear in the target hex. NOTE: Your result may 

not be the 3 Men shown at the left - fire is calculated and the computer generated value attained will vary. 

Right click a second time because artillery units have enough MPs to take two shots per turn. Other unit types, using 

Direct Fire, can fire up to three times if they do not expend any MPs to move prior to firing. 

It is generally a good idea to fire your artillery early in the turn. That way, the enemy is softened up by your barrage 

before you try to capture the hex by assaulting.  However, with experience you will learn when it is best to reserve some 

artillery for later, especially when there aren't many enemy units are visible, or you expect to breakthrough anyway and 

come across unspotted defenders in the enemy rear areas. 

Next, you are going to try Direct Fire. With Direct Fire, the units can actually see the enemy at which they are shooting. 
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Select the recon unit you moved earlier.  Unless it took fire and was disrupted, it should have its remaining movement 

points shown in yellow.  This means it can still fire 1 time – if its movement was red it couldn't fire at this point, if green 

but it had moved it could still fire twice, and if it hadn't moved it could fire its full 3 times still, or fire once or twice and 

then move.  

(Tip: If you do not want to select ALL units in the hex, you can EITHER place the cursor in the hex and then click on the 

units you want in the Unit Window, one unit at a time, OR, you can double click on the hex, which selects all the Units, 

and then single click on the units in the Unit Window that you do not want selected, to De-select them.)  

 

With the unit selected in the hex shown above, hold the Control (Ctrl) button down. You notice the cursor turns into a 

Crosshairs, like when you were firing the artillery. 

Right click on the enemy unit to fire a single shot at it with each of your units. Again, there will be a flash on the target 

hex, the sound of gun fire, and a possible result of losses in the enemy target hex. Also, the enemy unit may return fire 

and you may suffer some losses yourself.  You can try firing again but the unit will not fire as its movement points 

available now show Red. 

If you click on the enemy unit, you can see the target is made up of “Vehicles.” The strength of the enemy unit is not 

displayed. With Fog-of-war (FOW) on, the X value tells you there are between 1 and 9 vehicles in this unit. If there were 

10 or more it would show XX, or if 100 or more XXX.  The same applied to Man and Gun units. 

Air Support 

 

Recall back to the start of game, the first thing you saw was the Command Report. 
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As you can see, one of the lines in the report said you had ***Air units available*** for your use this turn. 

To further soften up the target, you may use an air mission. Click your cursor on the hex with the 

enemy units. Now click the Call Air Mission button on the Toolbar. 

 

 

An Air Mission Dialog will appear showing any available air units. In this example you see the 33rd Fighter Group of 36 P-

37 Lightning’s available. 

Click on the air unit in the 

dialog, and then OK.  

As with other combat 

results, the air mission will 

be conducted against the 

selected hex. The combat 

results will be displayed on 

the screen, or an air unit 

interception message will 

appear. If the air unit gets 

through, all anti-aircraft 

(AA) fire against your air 

unit will occur first, with the 

result of each AA fire displayed. Then, you will be shown the result of your air attack. Results shown in yellow letters are 

disruptions of the target unit. 

 

(Tip: There may be one more remaining air unit that you could also use, depending on what was available in your play. 

However, unlike artillery, Air Missions used in one turn have to wait while the planes are refitted, rearmed, and repaired 

before they are available again. So, it is best to not use them all, unless you really need to.) 

Fixed Units 

So far, you have moved a single unit into contact with the German forces. But there are still 

many units on the map that have not yet been considered. As it happens, many of these 

units are not available to you this turn. They are present, but because of readiness, orders, 

or just some condition identified by the scenario designer, they cannot be moved. 

Press the Fixed Units button on the Toolbar. Most of your units are now highlighted. 
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Click on any hex with highlighted units and you will see these units are designated as “Fixed.” They will be released for 

use on a later turn.  

 

 

 

You can check to see a schedule of released units, if you wish, using the menu “Units 

=> Releases.” 

Now that you know which units are “Fixed,” you can focus your attention for the 

remainder of the turn on those units which are not Fixed - a band of units clustered 

along the minefield belt, marking the Front Line. 

Additional Moves 

Outside of the fixed units, however, you have 4 units that can 

still move. You can find these units with the Next Stack button.  

Using it will select each unmoved unit on the map.  

Your forward tanks and recon units can move to surround the German unit, setting it up for 

destruction in turn 2. 

Use reachable hexes ON when making these moves to 

show where units can move to. Also move a single unit at a 

time.  

Move these units as shown forward toward the enemy 

unit that you have spotted.  Use the technique explained 

earlier when you clicked on the unit with the left mouse 

button and held down the mouse button, then dragged 

the cursor to the new location. 

You will be able to surround the German as shown in the 

smaller inserted in the upper corner of the planned moves. 

Be aware, this movement may draw opportunity fire from 

the German unit, but it is unlikely to disrupt the plan we 

have formed. Just continue your movement to the planned 

hexes after you have been fired upon.  

 

When you are satisfied you have made every move you 

can, consider “Saving” your file, either using the button or 

the menu item under File => Save.  
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(Tip: At the end of a turn, experienced players often save a copy of their file with a turn number. Then they repeat with a 

“File => Save As” to the default battle file name. This way, they retain a backup file and keep a record of the game as it 

progresses, for later review.)  

Finally, after you have made every move, fired every unit, and performed every action you wish to 

do, press the Next Turn button. 

 

The Other Side’s Turn 

When you press the Next Turn button, control of the game reverts to the other side, the A/I. Sit back, relax, and observe 

the action. 

It will likely start with a barrage of artillery from artillery. 

This will be followed by Direct Fire from enemy unit(s)  in contact with your units. 

You will see combat results with each shot, some of them may unfortunately be yellow colored, indicating a unit has 

been disrupted. 

Sometimes, your own units will fire back using Opportunity Fire - all under computer control, like your opponent’s units 

did during your turn. 

When complete, the A/I will end the turn and control will revert back to you for your second turn. 

Turn 2 

 

When the Command Report appears on your screen, control has been restored to you for your second turn. 

This time, your report is longer and may be scrollable if there is enough information although that is unlikely in this 

scenario. It reports: 

 Reinforcements have arrived. 
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 Units that have been released. 

 Some units may report Low Ammo (unavailable for artillery) and will not be as effective at fighting this turn. 

 Disrupted units are checked for disruption recovery and the Command Report tells you how many succeeded 

out of how many were checked. 

 Mines may be cleared if engineers are removing any on the map. 

 Air Units available. 

 HQs out of command. 

 A list of units isolated. 

 Other items. 

(Tip: You can click on any item in the Command Report with a hex location to jump instantly to that area of the map.) 

Click OK when you are done viewing the Command Report. 

(Tip: During your turn, you can recall the last Command Report by selecting the item under the Info menu.) 

 

Once the Command Report is closed, you will notice a few things on the map are different.  

There will probably be at least one more Axis Unit visible as your units in moving forward can see hexes that were not 

visible before.  Also the visibility range could have increased on decreased, affecting what can be seen.  
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Reinforcements 

Many veteran players like to place newly arriving units, or reinforcements, onto the map as their first 

action. 

 

Press the Arrived Units button to see a list of all new reinforcements.  There is a single unit coming on this second turn, 

the British 78th Division HQ. 

Double click on the line for the 

reinforcement to bring it onto the map.  

In some situations, reinforcements will 

have a protection setting on them that 

you won't see in the dialog.  This setting 

will impact any enemy units within that 

range so that the reinforcement may 

enter the map safely, preventing enemy 

units from blocking their entry.  Other 

times, the enemy is able to block the 

entry, when that is appropriate. 

Assaulting  

Now you are going to order an advance into the hex occupied by 

the German unit isolated in your first turn, as shown in the 

image to the right. To enter an enemy occupied hex, you must 

assault it, using only undisrupted units. 

As with movement, there are two ways to Assault. With the unit 

selected, you can right click in the enemy occupied hex because 

that is essentially what you are doing - attempting to move one 

hex into the German held hex, and hopefully defeat the 

defender.  

Alternatively, with the stack selected, you can hold the left 

mouse button down and drag the mouse to the German 

occupied hex. With either method, the result is the same - an 

Assault Status box appears, announcing the initiation of an assault. 

An assault can trigger defensive fire, which may result in losses or even disruption of a friendly unit. Disrupted units are 

not allowed to participate in an assault, which will stop the attack.  

(Tip: If you feel the assault is ill advised for any reason, you can cancel the order from the menu “Assault => Cancel 

Assault.”) 
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You can add units from several different hexes in the same assault. However, in this simple example, you only need to 

use the single tank unit. 

 

To resolve your assault, click the Resolve Assault button on the Toolbar. 

Results will appear showing losses on both sides. Attacker losses are shown first, followed by those of 

the defender. If you won, and any remaining enemy retreat (or are eliminated), your units will automatically advance to 

capture the hex. 

NOTE: In some assaults such as this one, the enemy retreat may be blocked. In this instance, if you win, the defender will 

remain in place but will incur additional losses. In this situation, your forces, even though victorious, will not be able to 

occupy the hex. 

REMEMBER: Do not worry if your outcome does not match the one illustrated, as results will vary with play.  

Finishing the Game 

You now know how to Move your units, Fire, Assault with your forces, and call for Air Support. With the Objective 

marker on the map and the Victory levels in mind, continue moving and firing your units in any manner you see fit. The 

end of the game will be announced at the conclusion of the Axis’ final turn, at which time, final Victory Points will be 

shown. 

You can restart the scenario at any time by selecting the File => Selection menu. A list of scenarios will appear from 

which you may select. After you feel comfortable with this smaller scenario, you can move on to the larger Campaign 

scenario that is also part of this demo. Maybe even enlist a friend to try Panzer Campaigns and you can play against each 

other, either HOT SEAT on one computer, or anywhere around the world using Play-by-Email (PBEM). 

Further Information 

However, there is no substitute for reading the Game PDF Documentation, which you can also access from the game 

Help menu. The rules of the game are divided into two parts: the User Manual and General Help. 

The user.pdf (user.PDF) is the rulebook which explains all game concepts by topic. You can open the User Manual from 

the Help menu or by pressing F2. This manual elaborates on the topics discussed in the Getting Started PDF and outlines 

additional rules you need to become familiar with.  

The pzc.pdf (pzc.PDF) covers the various elements of the interface, such as Menus, Dialogs, and Other Features including 

user.pdf
pzc.pdf
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Hex Area Info, the Toolbar, the Status Bar, and Hot Keys. You can open General Help from the Help menu or by pressing 

F1.  

 

Pressing F4 invokes the Parameter Data Dialog. It provides a host of information, such as movement costs, terrain 

benefits, and stacking limits, to name just a few. 

Lastly, documentation for the game’s editors may be found in the Help Menu when each editor is opened. 

ENJOY! 

 


